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Resumen 

Esta investigación tiene por objetivo analizar la pérdida de cobertura vegetal del 

distrito de Morales en el periodo 1987 – 2017. 

El método empleado consiste en el análisis multitemporal de imágenes satelitales, 

mediante la técnica de clasificación supervisada con el Software ArcGIS, aplicado al distrito 

de Morales, San Martín, Perú. En los periodos 1987-1997, 1997- 2007 y 2007-2017. 

El análisis presenta resultados del cambio de cobertura vegetal en el distrito de 

Morales, se puede observar que: en el periodo de 1987-1997 tenemos -948.42 ha, así 

mismo en el periodo 1997-2007 tenemos -81.83 ha y en el periodo 2007-2017 tenemos -

59.26 ha de pérdida de vegetación. 

Ante esto se puede concluir que la cobertura vegetal del distrito de Morales está 

experimentando cambios, registrándose la pérdida de -948.42 ha en el primer periodo, -

81.83 ha en el segundo y -59.26 ha en el tercero, a consecuencia de incremento del cambio 

de uso del suelo y la expansión del crecimiento urbano, factores que están influyendo 

negativamente e incidiendo en la disminución de la cobertura vegetal. 

 

Palabras claves: cobertura vegetal; análisis multitemporal; imágenes satelitales; 

clasificación supervisada. 
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Abstract 

This research aims to analyze the loss of vegetal coverage in the district of Morales 

in the period of 1987-2017. 

The method used consists of the multitemporal analysis of satellite images, using the 

supervised classification technique with the ArcGis Software, applied to the district of 

Morales, San Martin – Peru. In the periods 1987-1997, 1997- 2007 y 2007-2017 

The analysis presents results of the change of vegetal coverage in the Morales 

district, it can be seen that: in the period 1987-1997 we have -948.42 ha, likewise in the 

period 1997-2007 we have -81.83 ha and in the period 2007- 2017 we have -59.26 ha of 

loss of vegetation. 

Given this, it can be concluded that the vegetal coverage of the district of Morales is 

undergoing changes, registering the loss of -948.42 ha in the first period, -81.83 ha in the 

second and -59.26 ha in the third, as a result of increased change in land use and the 

expansion of urban growth, factors that are negatively influencing and impacting the 

decrease of vegetal coverage. 

 

Keywords: vegetable cover, multitemporal analysis, satellite images, supervised 

classification. 
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1. Introducción 

En la actualidad el cambio en la cobertura vegetal es uno de los más severos efectos 

de las actividades antrópicas en la faz de la tierra (Soulé & Orians, 2001), asimismo ésta es 

una de las principales causas del incremento de las tasas de extinción de especies en las 

décadas recientes (Galeana, Corona, & Ordóñez, 2008). 

Entre las consecuencias de este problema está la reducción y fragmentación del 

hábitat [(Meffe & Carroll, 1994);(Murcia, 1995)] con la consecuente disminución de la 

biodiversidad, y la eliminación de variabilidad genética de poblaciones y especies 

(Saunders, Hobbs, & Margules, 1991) sumado a una clara pérdida de los servicios 

ambientales y bioculturales. Todas estas estimaciones son indicadores de un severo 

problema que se está acentuando y que tiene relación directa con el cambio en la cobertura 

vegetal hacia otro uso del suelo y el deterioro ambiental (Lambin, 1994; Ordóñez et al., 2008 

citado por (Galeana et al., 2008). 

Los estudios que tienen relación a los cambios de la cobertura vegetal, obtienen 

mayor importancia debido esencialmente a las repercusiones de la deforestación (Brown y 

Lugo, 1994; Lund, 2000; Schlamadinger y Karjalainen, 2000; citado por  (Galeana et al., 

2008). Dicho proceso genera la reducción de la cubierta vegetal, daño de los recursos 

forestales, el deterioro físico y químico del suelo, alteración del balance hídrico y la 

desestabilización de cuencas; que repercuten en  los patrones climáticos y contribuyen al 

calentamiento global (Houghton, 1991; Lugo, 1992; Whitmore, Meli 2003; Lund, 2006; citado 

por Galeana et al., 2008). 

Según el Ministerio del Ambiente, se han perdido 403 mil hectáreas de cobertura 

boscosa en la región San Martín en los últimos quince años y representa el 20,4 % de la 

deforestación observada a nivel nacional (Banco Central de Reserva del Perú & Gobierno 

Regional de San Martín, 2017). 

Actualmente, de las 57120 ha con la que cuenta la subcuenca del río Cumbaza; 48 

596 ha corresponden al 85% de áreas alteradas por la actividad antrópica (deforestación) 
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con fines forestales, agrícolas y ganaderos y tan sólo 8 524 ha, correspondientes a un 15% 

del área total de la cuenca, lo constituyen bosques primarios no intervenidos 

(PDC[Municipalidad Distrital de Morales], 2014). 

El distrito de Morales comprende un área aproximadamente de 5250.97 hectáreas, 

se caracteriza por que las zonas de protección y conservación ecológica representan gran 

porcentaje del territorio (24.91%). También, existen zonas de recuperación; siendo el 

16.59% y las zonas para producción forestal y otras actividades productivas el 0.89%; sin 

embargo, el mayor porcentaje (52.85%) está constituido por las zonas con potencial en 

actividad agropecuaria (PDC[Municipalidad Distrital de Morales], 2014). 

En este sentido, las coberturas vegetales son importantes debido a que constituyen 

un elemento representativo del componente ambiental y la relación con el bienestar y la 

calidad de vida de los habitantes, lo cual representa un factor determinante en el desarrollo 

local y regional (Cortes & Rubio, 2016). 

El análisis presenta la evolución, en particular (el Distrito de Morales, de la provincia 

y departamento San Martín, Perú), que sirve como modelo para estudiar la pérdida de la 

cobertura natural (selvas y bosques), producto del crecimiento urbano, las actividades 

agrícolas entre otras, las cuales inciden en la fertilidad y la erosión del suelo. 

Contexto geográfico 

El lugar de análisis del presente estudio es el distrito de Morales, se encuentra 

ubicado en el sector Noroccidental y cordillera sub-andina, en la Selva Alta de la Amazonía 

Peruana, en la jurisdicción del Departamento de San Martín, ocupado aproximadamente por 

23,561 habitantes. En las coordenadas geográficas son Latitud Sur 6º 36’ 15’’ y Latitud 

Oeste 76º 10’ 30’.  

La precipitación pluvial en esta zona es de 2600 mm/año, con una temperatura 

promedio de 24.8°C mínima y 27.3° C máxima, pero con variantes locales de acuerdo al 

grado de deforestación y presencia de valles (en zonas urbanas puede llegar a 30°C por 

efecto de la radiación solar entre las 11 de la mañana y 2 de la tarde). Por el relieve 
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accidentado y una fisiografía que varía desde los 3500 a 283 msnm, del distrito 

(PDC[Municipalidad Distrital de Morales], 2014). 

La región de San Martín geológicamente se encuentra asentado dentro de la 

Cordillera de los Andes y un sector de la Llanura Amazónica. Geo estructuralmente está 

limitado, hacia el Oeste por la Cordillera Occidental y al Este por el Llano Amazónico y el 

Cratón Brasileño. Geográficamente se localiza en el sector noroccidental del Perú, limitados 

al este por los departamentos de Ucayali y Loreto; al oeste por La Libertad y Cajamarca; al 

norte por Amazonas y por el sur con el departamento de Huánuco, ver Ilustración N° 01. 

Posee una extensión aproximada de 5 179 642 ha (Castro, 2005).  

Ilustración N° 01. Mapa Región San Martín 

 

Fuente. Elaboración propia, 2020. Base Cartográfica GRSM. 

Relación entre uso y cobertura del suelo 

La cobertura de suelo hace alusión a los elementos que conforman la expresión 

biofísica observable de la superficie terrestre. Generalmente, los componentes de la 
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cobertura vegetal se encuentran agrupados en la vegetación y coberturas que están unidas 

a la infraestructura antrópica. Asimismo, el uso de la tierra está integrada a las actividades 

humanas que buscan generar bienes y servicios mediante al mantenimiento, remplazo y 

alteración del mismo (Secretaría General de la Comunidad Andina, 2012). 

Las características físicas de la superficie de la tierra, se encuentran capturadas en 

la distribución de la vegetación, el suelo, el agua y otras características físicas del suelo, 

incluidas las que fueron creadas únicamente  debido a las actividades humanas (Rodríguez, 

2018).  

El uso de suelo está conformado por las actividades humanas que pretenden 

generar flujos de bienes y servicios mediante el mantenimiento, reemplazo y alteración de la 

cobertura de suelo (Secretaría General de la Comunidad Andina, 2012). Asimismo, este uso  

se refiere a la forma en que la tierra es utilizada por los humanos y su hábitat, por lo general 

con énfasis en el papel funcional de la tierra para las actividades económicas (Rodríguez, 

2018). 

La relación entre la cobertura y uso del suelo, se expresa en un gradiente de 

intervención, desde los usos que generan modificaciones a los ecosistemas naturales (p.ej. 

tala selectiva) hasta los usos del suelo que reemplazan la cobertura original (p.ej. reemplazo 

de bosques nativos por pastizales) (Secretaría General de la Comunidad Andina, 2012). 

Por este motivo el suelo se ha convertido en indicador de la calidad ambiental, 

cuando la su cobertura, está directamente relacionada con su uso, se hace necesario 

identificar la dinámica de este proceso para conocer las tendencias de degradación, 

desertificación o pérdida de biodiversidad (García, 2008). 

El cambio en la cobertura vegetal del suelo 

La cobertura de suelo, viene a ser la cubierta de vegetación natural que cubre la 

superficie terrestre, la cual comprende una amplia gama de biomasas con diferentes 

características fisonómicas y ambientales que abarca desde pastizales hasta las áreas de 

revestimiento por bosques naturales (García, 2008). Del mismo modo, el cambio de la 

cobertura del suelo es explicada como la conversión, apropiación y utilización no natural de 
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los suelos para usos distintos, generalmente atribuido a procesos de deforestación, 

degradación del suelo, producto de las actividades humanas y fenómenos naturales (Alegre, 

2017). 

La urbanización involucra la transformación del suelo, las fusiones subdivisiones y 

fraccionamientos de áreas y predios ya sean rurales o urbanos. Asimismo, implica el 

crecimiento de los centros de población: expansión espacial y demográfica, ya sea por 

extensión física territorial del tejido urbano, por el acrecentamiento en las densidades de 

construcción y población, o también por ambos aspectos. Este aumento puede darse de 

manera anárquica o equilibrada (Alonzo & Gónzales, 2010). 

Causas de los desequilibrios en la cobertura vegetal 

Se encuentra el crecimiento no planificado de las ciudades y su permanente 

expansión hacia el medio ambiente natural, ha hecho del crecimiento urbano un factor 

generador de graves impactos ambientales (Osorio, 2009). Asimismo, el crecimiento urbano 

es consecuencia de la dinámica poblacional, siendo la variación que ocurre en la 

composición de la población con el transcurso de los años. El aumento acelerado de la 

población urbana, rural y el desarrollo de las ciudades es un fenómeno natural, incontenible 

y necesario. A medida que un país pasa de una economía agrícola a una economía 

industrial, se produce una migración en gran escala del campo a la ciudad (León, 2015). 

Entre las causas principales que amenazan la cobertura vegetal se encuentran la 

presión antropogénica sobre los recursos forestales (extracción de madera, tala 

clandestina), práctica de actividades como la roza, tumba y quema, con el fin de aperturar 

nuevos espacios para el establecimiento de la agricultura y ganadería, ocasionando de esta 

manera un desequilibrio ambiental, que pone en riesgo la supervivencia de las poblaciones 

animales y vegetales que habitan este patrimonio ecológico (Camacho et al., 2015). 

Existen otros factores que son causantes de le pérdida de la cobertura vegetal, pero 

los más visibles con producto de las actividades antropogénicas, entre los cuales se 

detallan los siguientes: (Álvarez & Agredo, 2013) 
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 Carencia de una planificación para la mejora de la Zonificación Económica y 

Ecológica, por parte de las autoridades competentes. 

 Aumento de la población. 

 Aumento de las actividades agrícolas y ganaderas.    

 Deficiencia en el control urbano y rural.  

Usos de los sistemas de Información Geográfica 

Un sistema de información geográfica (SIG) es una herramienta informática que 

sirve para ingresar, almacenar, gestionar, recuperar, actualizar, analizar y producir 

información, sus datos están relacionados con las características de las zonas y lugares 

geográficos (ONU, 2000). Por otro lado, el SIG es una interacción y un proceso organizado 

en el cual influyen los hardware, software, datos geográficos y personal idóneo, diseñada 

para capturar, guardar, manejar, analizar, modelar y representar de forma concreta la 

información geográficamente referenciada, con el objetivo de brindar una correcta 

planificación y gestión de los datos analizados, con la construcción de estrategias que nos 

permitan modelar descriptiva y predictivamente la evolución temporal y espacial  de los 

elementos del ambiente vegetal (Sastre, 2010). 

Mediante el uso del SIG se puede realizar análisis de la evolución de las coberturas 

y usos de suelo en el tiempo y desde una perspectiva multidisciplinar, la cual va a permitir 

realizar una adecuada orientación de acciones futuras (García, 2008). Asimismo, se puede 

llevar a cabo la clasificación supervisada de las imágenes satelitales, a través de una 

exploración de las clases de análisis estadístico variado, este proceso nos ayuda a identifica 

los valores de cada píxel de una o varias bandas de una imagen ráster, crea y evalúa las 

clases o clúster (firmas), finalmente reclasifica de acuerdo con las probabilidades de cada 

clase. Este procedimiento es muy práctico para crear de forma automática un mapa de uso 

del suelo o de cobertura (Arcgeek, 2012).  

Usos de la teledetección 
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Es una técnica que nos permite adquirir información de la superficie terrestre a 

través de imágenes proporcionados por sensores que están a bordo de satélites espaciales, 

así mismo la aplicación de esta técnica se basa en la discriminación y estratificación de 

áreas para muestreos multietápicos necesarios para derivar tamaños y números de 

muestras (Chuvieco, 1995). 

Los resultados gráficos son el proceso de manipulación digital e interpolación de 

datos, que permite generar los resultados que se observarán a continuación, como son las 

coberturas del área en estudio, estas apoyados en un trabajo de software de 

georreferenciación, y coordenadas que facilitan la aproximación a una realidad del contexto 

que se presenta (Álvares & Agredo, 2013). 

2. Materiales y Métodos 

2.1. Materiales 

 Laptop Hp Core i5 - 12GB RAM 

 Libretas de apuntes   

 Software ArcGIS 

 Software Google Earth Pro 

 Portales EROS | EarthExplore, para la visualización de imágenes de satélites 

históricas. 

2.2. Métodos 

2.2.1. Revisión bibliográfica y determinación de la metodología. 

La recopilación de información se realizó a partir de libros, revistas, tesis y artículos 

científicos con la finalidad de establecer una base informática con temas relacionados al 

comportamiento de la cobertura vegetal y también determinar la metodología para el 

desarrollo de la presente investigación. 
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La metodología seleccionada fue el análisis multitemporal de imágenes satelitales 

basados en la técnica de clasificación supervisada y los procedimientos serán realizados a 

través. 

También se utilizó la guía: PROCEDIMIENTO TÉCNICO Y METODOLÓGICO PARA 

LA ELABORACIÓN DEL "ESTUDIO ESPECIALIZADO DE ANÁLISIS DE LOS CAMBIOS 

DE LA COBERTURA Y USO DE LA TIERRA" de la Resolución Ministerial N° 081-2016-

MINAM. Del presente documento se consideró el periodo de análisis (10 años), además de 

la fórmula de Tasa de Cambio, las imágenes satelitales a usar, el análisis de datos y la 

interpretación de resultados del Sistema de Información Geográfica, software ArcGIS 

versión 10.5. 

2.2.2. Obtención de mapa base y delimitación del área de estudio. 

El área de estudio fue el distrito de Morales, se obtuvo de la delimitación geográfica 

proporcionada por la Base Cartográfica del Gobierno Regional de San Martín DATUM: 

WGS84 UTM, Zona: 18 Sur. 

El distrito de Morales se encuentra ubicado en la provincia y departamento de San 

Martín, Perú. Comprende un total de 5250.97 hectáreas, sus límites con los siguientes: 

Por el Norte: con el Distrito de San Antonio de Cumbaza 

Por el Sur: con el Distrito de Juan Guerra 

Por el Oeste: con el Distrito de Cacatachi 

Por el Suroeste: Con el Distrito de Cuñumbuque 

Por el Oeste: Con el Distrito de Tarapoto 
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Ilustración N° 02. Establecimiento del área de análisis  

 

Fuente. Elaboración propia, 2020. Base Cartográfica GRSM. 

2.2.3. Obtención de imágenes satelitales 

Las imágenes satelitales para la presente investigación fueron las imágenes 

Landsat, las cuales se obtuvieron desde el portal de EARTH EXPLORER- USGS (Servicio 

Geológico de los Estados Unidos) para los años 1987, 1997, 2007 y 2017. 

Tabla N° 01. 

Satélites del portal USGS usados 

Año Satélite 

1987 Landsat 4-5 TM C1 Level -1 

1997 Landsat 4-5 TM C1 Level -1 

2007 Landsat 4-5 TM C1 Level -1 

2017 Landsat 8 OLI/TIRS C1 Level-1 

Fuente. Elaboración propia, 2020. 

2.2.4. Identificación de la unidad de análisis 

La unidad de análisis de la presente investigación fue la cobertura vegetal, se refiere 

a los elementos que constituyen la expresión biofísica observable de la superficie terrestre y 

a las coberturas que están unidas a la infraestructura antrópica, la vegetación. 



15 
 

2.2.5. Clasificación supervisada de las imágenes satelitales 

 Primeramente, se vinculó la imagen satelital al software ArcMap 10.5 

 Luego de realizó el corte de la imagen satelital de acuerdo a la delimitación del 

área de estudio, para ello se hará uso del geoprocesamiento Clip. 

 Se procedió a clasificar la imagen satelital por medio de cada píxel de una 

celda, la clase de área de estudio (muestra) será: “Cobertura vegetal”. Para 

ello se creó un shapefile con la clase de entidad puntos, se marcó los puntos 

de acuerdo a la muestra y se asignó un código de identificación. 

 Posteriormente se generó y guardó un archivo de firma espectral con la 

herramienta Create Signatures [ArcToolbox > Spatial Analyst Tools > 

Multivariate > Create Signatures; se seleccionó el ráster (imagen satelital), 

seguidamente del vector (shapefile con muestra de identificación) y el código 

de identificación] 

 Después se procedió a la obtención de la clasificación del área de estudio con 

la herramienta Maximum Likelihood Classification [ArcToolbox > Spatial 

Analyst Tools > Multivariate > Maximum Likelihood Classification, usando la 

imagen ráster y el shapefile con el campo de los valores numéricos] 

 A continuación, se hizo la conversión del ráster a shapefile, para utilizó la 

herramienta Conversion Tools [ArcToolbox > Conversion Tools>From Raster> 

Raster to Polygon]. 

 Finalmente, con el archivo anterior se determinó el área total de la clasificación 

del ráster “Cobertura vegetal” haciendo uso del geoprocesamiento Dissolve. 

También se exportó los mapas (File>Export Map).  

2.3. Participantes 

Dentro de ésta área se considera la participación de los autores y asesor del 

presente trabajo de investigación, alumnos de la carrera de ingeniería ambiental de la 

Universidad Peruana Unión. 
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2.4. Análisis de datos 

Se determinó la Tasa de cambio de la cobertura vegetal para los periodos 1987-

1997, 1997-2007 y 2007-2017 mediante la ecuación de la Tasa de cambio, obtenido de la 

guía: Procedimiento Técnico y Metodológico para la Elaboración del "Estudio Especializado 

de Análisis de los Cambios de la Cobertura y Uso de la Tierra" de la Resolución Ministerial 

N° 081-2016-MINAM. La ecuación es la siguiente: 

Ilustración N° 03. Formula de la Tasa de Cambio 

 

Fuente. (MINAM, 2016) 

Donde: 

Tc: es la tasa de cambio 

t1 y t2: son las superficies de la cobertura vegetal en el año inicial y final 

respectivamente. 

t: equivale a la amplitud del periodo analizado. 

3. Resultados y Discusión 

3.1. Resultados obtenidos del análisis de la distribución de la cobertura 

vegetal 

Tabla N° 02.  

Distribución de la cobertura vegetal según años  

Área (Ha) 

Distrito 

Morales 

Año Cobertura 

Vegetal 

(Ha) 

Porcentaje 

Cobertura 

Vegetal (%) 

Recurso 

Hidrológico 

(Ha) 

Crecimiento 

urbano 

5250.97 

1987 2690.37 51.24 95.35 2464.48 

1997 1741.95 33.17 185.68 3320.36 

2007 1660.12 31.62 176.20 3412.09 
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Fuente. Elaboración propia, 2020. 

En la Tabla N° 02, se observa que, la unidad de cobertura vegetal del distrito de 

Morales en el año 1987 ocupa 2690.37 hectáreas, que representa el 51.24% del total de la 

superficie de análisis; en el año 1997 ocupa 1741.95 hectáreas, que representa el 33.17%; 

asimismo se observa que en el año 2007 ocupa 1660.12 hectáreas, que representa el 

31.62% y en el año 2017 ocupa 1600.86 hectáreas el cual representa el 30.49% del total de 

la superficie del distrito de Morales. 

 

 

3.1.1. Mapas obtenidos de la clasificación supervisada de imágenes 

satelitales según año de estudio. 

2017 1600.86 30.49 190.95 3456.82 
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Ilustración N° 04. Cobertura de uso de suelo del año 1987. 

 

Fuente. Elaboración propia, 2020. Base Cartográfica GRSM. 
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Ilustración N° 05. Cobertura de uso de suelo del año 1997. 

 

Fuente. Elaboración propia, 2020. Base Cartográfica GRSM. 
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Ilustración N° 06. Cobertura de uso de suelo del año 2007. 

 

Fuente. Elaboración propia, 2020. Base Cartográfica GRSM. 
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Ilustración N° 07. Cobertura de uso de suelo del año 2017. 

 

Fuente. Elaboración propia, 2020. Base Cartográfica GRSM. 

3.2. Resultados de la determinación de cambios en la cobertura vegetal 

Desarrollado en el área del distrito de Morales en los tres periodos de estudio. 
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Tabla N° 03.  

Tasas de cambios en la cobertura vegetal 

Fuente. Elaboración propia, 2020. 

En la Tabla N° 03 se observa que, en los periodos analizados hubo una reducción 

de la cobertura vegetal. En los años 1987-1997 se redujo 948.42 hectáreas de cobertura 

vegetal, en el 1997-2007 presenta una reducción de 81.83 hectáreas y en los años 2007-

2017, disminuyo un 59.26 hectáreas de cobertura. 

3.3. Resultados de la determinación de la Tasa de Cambio de la cobertura 

vegetal 

Desarrollado en el área del distrito de Morales en los periodos 1987-1997, 1997-

2007 y 2007-2017, se utilizó de la fórmula de Tasa de cambio (Ver Ilustración N° 03. Formula 

de la Tasa de Cambio). 

Tabla N° 04. 

Tasas de cambio en la cobertura vegetal según periodos de estudio 

Fuente. Elaboración propia, 2020. 

 

Periodo 
Año 

Cobertura 

Vegetal (Ha) 

Diferencia por periodos 

(Ha) 

1 
1987 2690.37 

-948.42 
1997 1741.95 

      2 
1997 1741.95 

-81.83 
2007 1660.12 

       3 
2007 1660.12 

-59.26 
2017 1600.86 

Periodo Tasa de cambio 

1987-1997 -0.043 

1997-2007 -0.005 

2007-2017 -0.004 
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Gráfico N° 01. Gráfico de la Tasa de Cambio. 

 

Fuente. Elaboración propia, 2020. 

En la Tabla N° 04 y el Gráfico N° 01, se observa la tasa de cambio de la cobertura 

vegetal existente en los periodos de análisis, notándose que entre los años 1997-2017 

existió menor tasa de cambio y es de -0.004, sin embargo, todos los valores de tasa de 

cambio obtenidos son negativos, por lo tanto, podemos decir que la cobertura vegetal ha 

variado, pero de manera descendente. 

3.4. Discusiones 

A partir de los resultados obtenidos, se determinó que la cobertura vegetal del área 

en análisis, ha experimentado cambios durante los años de estudio. 

Según la Tabla N° 01, la unidad de cobertura vegetal del distrito de Morales en el 

año 1987 ocupa 2690.37 hectáreas, que representa el 51.24% del total de la superficie; en 

el año 1997 abarca 1741.95 hectáreas, que constituye el 33.17%; asimismo se observa que 

en el año 2007 ocupa 1660.12 hectáreas, que representa el 31.62% y en el año 2017 

abarca 1600.86 hectáreas que  equivale el 30.49% del total de la superficie del área 

estudiada.  
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Los datos mencionados anteriormente, corresponden a los periodos de estudio 

1987-1997, 1997-2007 y 2007-2017. Asimismo, demuestran la disminución de la cobertura 

vegetal; en el primer periodo disminuyó 948.42, el segundo periodo presento una pérdida de 

81.83 ha y en el tercer periodo se perdió 59.26 ha de cobertura boscosa. 

En la Tabla N° 03, se observa la tasa de cambio de la cobertura vegetal existente en 

los periodos de análisis, notándose que entre los años 1997-2017 existió menor tasa de 

cambio y es de -0.004, sin embargo, todos los valores de tasa de cambio obtenidos son 

negativos, por lo tanto, podemos decir que la cobertura vegetal ha variado, pero de manera 

descendente.  

Ante esto se puede indicar que la cobertura vegetal del distrito de Morales está 

experimentando cambios y ésta se puede dar por el incremento del cambio de uso de suelo 

para las actividades humanas, factores que están influyendo negativamente e incidiendo en 

la disminución de la cobertura. 

4. Conclusiones y Recomendaciones 

4.1. Conclusiones  

El trabajo de investigación permitió analizar los cambios en la cobertura vegetal de la 

superficie del distrito de Morales en los periodos 1987-1997, 1997-2007 y 2007-2017. Este 

análisis nos muestra un descenso de la cobertura vegetal, registrándose la pérdida de -

948.42 ha en el primer periodo, -81.83 ha en el segundo y -59.26 en el tercero.  

Estos datos nos sirven para realizar una planificación de consumo responsable, 

vigilancia de los recursos naturales para asegurar su sostenibilidad y permanencia en el 

presente y el futuro. Mejorando la calidad de vida de los seres vivos, así mismo para 

reforestar áreas desnudas e incentivar la conservación de los recursos naturales para aliviar 

y mitigar los efectos que esto produce como es el cambio climático.  

En conclusión, es importante precisar que la planificación para la reforestación de 

áreas degradadas y la concientización ambiental ayudarían a mitigar los efectos que 
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produce el cambio de uso de suelo, favoreciendo la conservación de los recursos naturales 

del distrito de Morales. 

4.2. Recomendaciones  

Los resultados obtenidos en la investigación podrían servir para realizar una 

planificación de consumo responsable y vigilancia de los recursos naturales, para asegurar 

su sostenibilidad, permanencia hacia el futuro y mejorar la calidad de vida de los seres 

vivos, así mismo para reforestar áreas desnudas e incentivar la conservación de los 

recursos naturales para aliviar y mitigar los efectos del cambio climático. Asimismo, los 

resultados obtenidos podrían servir para elaborar planes de zonificación ecológica y 

económica para el desarrollo socioeconómico de la población del Distrito de Morales. 

Finalmente, la recomendación se encamina a la realización de estudios, que, a partir 

de datos temporales actualizados, conduzcan al análisis de la afectación de la cobertura 

vegetal producto de las actividades antrópicas 
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